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IMPORTANT

The information contained in this publication is subject to change without notice. This publica
is supplied "as is" without warranty of any kind, either express or implied, including but not lim
to the implied warranties or conditions of merchantability or fitness for a particular purpose. I
event shall Cross Products be liable for errors contained herein or for incidental or conseque
damages, including lost profits, in connection with the performance or use of this material wh
based on warranty, contract, or other legal theory.

This publication contains proprietary information which is protected by copyright. No part of t
publication may be reproduced in any form, or stored in a database or retrieval system, or trans
or distributed in any form by any means, electronic, mechanical photocopying, recording, or 
otherwise, without the prior permission of Cross Products Limited.
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The Katana GD Emulator (GD-M) and GD Workshop streamlines your CD product developm
cycle.

Using GD Workshop you can create a “virtual” CD and emulate it on the Katana developmen
This virtual CD can be edited and recreated instantly so that you can test the effect of change
project in seconds.

The Katana development box contains all the hardware required for real-time CD emulation an
Workshop provides remote control and logging of CD emulation and writing, plus a CD editin
suite.
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This chapter takes you through installing and configuring GD Workshop to work with the Kata
development box.

It has the following sections:

• Installing GD Workshop

• System Requirements

• Customising GD Workshop

• Configuring the GD-M hardware

• Configuring additional SCSI devices

• Configuring device drive letters

• Updating the GD-M firmware.
��
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To install GD Workshop:

1) Connect the Katana development box to your development computer in accorda
with the Katana development box installation instructions from Sega DTS.

2) Insert the Katana development tools CD into the CD drive on the development 
computer.

3) Run Setup.exe and follow the instructions on screen to install GD Workshop.

11227(�7(� ,I�\RX�DUH�UXQQLQJ�*'�:RUNVKRS�RQ�:LQGRZV�17���\RX�PXVW�EH�UXQQLQJ�LQ�$GPLQLVWUDWRU�

PRGH�
�
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GD Workshop requires:

• An IBM™ PC or compatible with 486 processor or above (Pentium™ recommende
• Windows® 95 or Windows NT™
• 12 MB or more of RAM.

127(�127(� ,I�\RX�DUH�UXQQLQJ�*'�:RUNVKRS�RQ�:LQGRZV�17���\RX�PXVW�EH�UXQQLQJ�LQ�$GPLQLVWUDWRU�

PRGH�

The hard disk space required on the development computer depends on the size of your proj
GD-ROM has 1.2 GB capacity and a conventional CD has 650 MB capacity.
�
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To customise GD Workshop:

1) On the Configuration menu, select Workshop.

2) On the Workshop Settings dialog box specify the settings you want.

([SDQG�WUHH�RQ�ORDG 7KLV�WHOOV�*'�:RUNVKRS�WR�DXWRPDWLFDOO\�H[SDQG�WKH�SURMHFW�WUHH�DQG�VKRZ�DOO�WUDFNV�
DQG�ILOHV�ZKHQ�\RX�RSHQ�DQ�H[LVWLQJ�SURMHFW�

&KHFN�IRU�XSGDWHG�ILOHV 7KLV�WHOOV�*'�:RUNVKRS�WR�FKHFN�WKH�GDWH�DQG�YHUVLRQ�RI�DOO�SURMHFW�ILOHV�RQ�WKH�
HPXODWLRQ�GULYH�DJDLQVW�WKH�VRXUFH�ILOHV�RQ�WKH�GHYHORSPHQW�FRPSXWHU��VR�WKDW�\RX�
FDQ�VHH�LI�WKH\�KDYH�FKDQJHG�VLQFH�WKH�SURMHFW�ZDV�ODVW�RSHQHG��,I�DQ\�ILOHV�KDYH�
FKDQJHG��D�GLDORJ�ER[�LQIRUPV�\RX�RI�WKHLU�VWDWXV�DQG�\RX�FDQ�FKRRVH�WR�XSGDWH�WKH�
ILOHV�RU�LJQRUH�WKH�FKDQJHV�
6HH�DOVR�.HHSLQJ�WUDFN�RI�ILOH�YHUVLRQV�

$XWR�UH�ORDG�ODVW�SURMHFW 7KLV�WHOOV�*'�:RUNVKRS�WR�DXWRPDWLFDOO\�RSHQ�WKH�ODVW�SURMHFW�\RX�ZHUH�ZRUNLQJ�RQ�
ZKHQ�LW�VWDUWV�XS�
�
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)ROORZ�ODVW�ILOH�RQ�GURS 7KLV�JLYHV�\RX�FRQWURO�RYHU�WKH�ZD\�WKDW�PXOWLSOH�ILOHV�DUH�GURSSHG�RQWR�WKH�SURMHFW�
WUHH��,I�\RX�DUH�GRLQJ�ORWV�RI�ODUJH�GURSV�RQWR�WKH�WUHH�KLV�RSWLRQ�VKRXOG�EH�
XQFKHFNHG�
:KHQ�FKHFNHG��\RX�FDQ�VHH�HDFK�ILOH�DV�LW�LV�DGGHG�WR�WKH�WUHH��DQG�ZKHQ�WKH�GURS�LV�
ILQLVKHG��WKH�ODVW�ILOH�ZKLFK�ZDV�DGGHG�LV�VHOHFWHG�LQ�WKH�WUHH�
:KHQ�XQFKHFNHG��WKH�WUHH�LV�EXLOW�LQVWDQWO\�DQG�\RX�DUH�UHWXUQHG�WR�WKH�WRS�RI�WKH�
WUHH�ZKHQ�WKH�GURS�LV�ILQLVKHG�

6KRZ�ORJ�GDWD�LQ�GHFLPDO 7KLV�WHOOV�*'�:RUNVKRS�WR�GLVSOD\�ORJ�GDWD�LQ�WKH�FRQWURO�ZLQGRZ��VXFK�DV�VHFWRU�
DGGUHVVHV��LQ�GHFLPDO��,I�LW�LV�QRW�FKHFNHG�WKH�ORJ�GDWD�DSSHDUV�LQ�KH[DGHFLPDO�

&UHDWH�VPDOO�ILOH�DUFKLYHV��6)$� 7KLV�WHOOV�*'�:RUNVKRS�WR�XVH�6PDOO�)LOH�$UFKLYHV�LI�\RXU�SURMHFW�FRQWDLQV�ORWV�RI�
VPDOO�ILOHV�OHVV�WKDQ���.��7KLV�LPSURYHV�WKH�*'�0ªV�SHUIRUPDQFH�ZKHQ�HPXODWLQJ�
DQG�ZULWLQJ�VPDOO�ILOHV�
6HH�DOVR�+RZ�DQG�ZKHQ�WR�XVH�VPDOO�ILOH�DUFKLYHV�

,QWLWLDO�7UDFN�7\SH 7KLV�VSHFLILHV�WKH�GHIDXOW�WUDFN�W\SH�WKDW�*'�:RUNVKRS�DGGV�WR�D�QHZ�SURMHFW�ZKHQ�
\RX�GUDJ�ILOHV�GLUHFWO\�LQWR�WKH�HPSW\�SURMHFW�ZLQGRZ�

$XWR�PD[LPLVH
$XWR�WLOH
$XWR�&DVFDGH

7KHVH�EXWWRQV�FRQWURO�WKH�DUUDQJHPHQW�RI�ZLQGRZV�LQ�*'�:RUNVKRS�ZKHQ�\RX�RSHQ�
QHZ�RU�H[LVWLQJ�SURMHFWV�

5HVWRUH�6WDWH 7KLV�WHOOV�*'�:RUNVKRS�WR�VDYH�WKH�SRVLWLRQ�RI�WKH�SURMHFW�WUHH�LQ�WKH�SURMHFW�
ZLQGRZ��<RX�PXVW�DOVR�KDYH�$XWR�UH�ORDG�ODVW�SURMHFW�VHOHFWHG�IRU�WKLV�WR�ZRUN�

*'�520�$XWR�EXLOG��DGG�ILOHV�WR�VHRQG�
VHVVLRQ

7KLV�WHOOV�*'�:RUNVKRS�DXWRPDWLFDOO\�EXLOG�D�WZR�VHVVLRQ�*'�520�DQG�WR�DGG�WKH�
ILOHV�WR�WKH�VHFRQG�VHVVLRQ�ZKHQ�\RX�GUDJ�DQG�GURS�ILOHV�LQWR�DQ�HPSW\�SURMHFW�
ZLQGRZ�
:KHQ�XQFKHFNHG��WKH�ILOHV�ZLOO�EH�DGGHG�WR�WKH�ILUVW�VHVVLRQ�

(PXODWH�*'�520�WLPLQJV :KHQ�VHW�WR�5HDO�.DWDQD�6SHHG��WKLV�WHOOV�*'�:RUNVKRS�WR�HPXODWH�D�*'�520�GLVF�
ZLWK�D�YDULDEOH�GDWD�UHWULHYDO�UDWH�IURP��[�DW�WKH�LQVLGH�RI�WKH�GLVF�WR���[�DW�WKH�
RXWVLGH�RI�WKH�GLVF��*'�:RUNVKRS�DOVR�HPXODWHV�*'�520�VHHN�WLPHV�

6HH�DOVR�*'�520�OD\RXW�DQG�VHFWRU�DGGUHVVHV�

:KHQ�VHW�WR�1R�6SHHG�5HVWULFWLRQV��*'�:RUNVKRS�HPXODWHV�DW�FRQVWDQW�GDWD�
UHWULHYDO�UDWH�DW�WKH�IXOO�VSHHG�RI�WKH�*'�0�ZLWK�QR�VHHN�GHOD\V��)XOO�VSHHG�LV���[�RU�
DERYH�GHSHQGLQJ�RQ�WKH�FRPSOH[LW\�RI�WKH�GDWD�

$SSHDUDQFH +HUH�\RX�FDQ�VSHFLI\�WKH�IRQW�XVHG�IRU�HDFK�SDUW�RI�WKH�GLVSOD\�LQ�*'�:RUNVKRS�
�
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To configure the GD-M Hardware:

1) On the Configuration menu, select Hardware.

2) On the Hardware Settings dialog box specify the settings you want.

Refer to the Katana development box Installation Manual for more details of how to configur
SCSI IDs.

+DUG�'LVN�,'
&'�%XUQHU�,'
&'�520�,'
,QLWLDWRU�,'

7KHVH�VKRZ�WKH�6&6,�,'V�IRU�GHYLFHV�RQ�WKH�.DWDQD�GHYHORSPHQW�ER[�6&6,�EXV��
5HIHU�WR�WKH�.DWDQD�GHYHORSPHQW�ER[�,QVWDOODWLRQ�0DQXDO�IRU�GHWDLOV�RI�KRZ�WR�
FRQILJXUH�6&6,�,'V�
6HH�DOVR�&RQILJXULQJ�DGGLWLRQDO�6&6,�GHYLFHV�

+DUG�'LVN�6WDUW�7LPH 7KLV�OHWV�\RX�VSHFLI\�WKH�WLPH�LQ�PLOOLVHFRQGV�WKDW�*'�:RUNVKRS�ZDLWV�DIWHU�VHQGLQJ�
D�VWDUW�XS�FRPPDQG�WR�WKH�HPXODWLRQ�GULYH��,I�WKH�GULYH�GRHV�QRW�UHDFK�RSHUDWLQJ�
VSHHG�ZLWKLQ�WKLV�WLPH�D�'ULYH�1RW�)RXQG�PHVVDJH�LV�UHSRUWHG�LQ�WKH�ORJ�LQ�WKH�
FRQWURO�ZLQGRZ�

(PXODWLQ�7LPHRXW 7KLV�OHWV�\RX�VSHFLI\�WKH�WLPH�WKDW�*'�:RUNVKRS�ZDLWV�DIWHU�VHQGLQJ�DQ�HPXODWH�
FRPPDQG�WR�WKH�*'�0��,I�WKH�*'�0�GRHV�QRW�VWDUW�WKH�HPXODWLRQ�ZLWKLQ�WKLV�WLPH�DQ�
(PXODWLRQ�)DLOHG�PHVVDJH�LV�GLVSOD\HG�
7KH�GHIDXOW�LV����VHFRQGV�DQG�WKH�PD[LPXP�LV������VHFRQGV��)RU�FRPSOH[�SURMHFWV�
ZLWK�ORWV�RI�ILOHV�DQG�RU�GLUHFWRULHV��\RX�PD\�QHHG�WR�LQFUHDVH�WKH�HPXODWLRQ�
WLPHRXW�
�
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'ULYH�5HPRYDEOH 7KLV�VSHFLILHV�ZKHWKHU�WKH�*'�0�DSSHDUV�WR�WKH�GHYHORSPHQW�FRPSXWHU�DV�D�IL[HG�
RU�UHPRYDEOH�GULYH��,W�VKRXOG�EH�VHW�WR�5HPRYDEOH�XQOHVV�\RX�DUH�IRUPDWWLQJ�WKH�
HPXODWLRQ�GULYH��ZKHQ�LW�LV�WHPSRUDULO\�FKDQJHG�WR�IL[HG�
6HH�DOVR�)RUPDWWLQJ�WKH�HPXODWLRQ�GULYH�

/RJ�(QWULHV 7KLV�VHWV�WKH�VL]H�RI�WKH�ORJ�RXWSXW�EXIIHU�RI�WKH�*'�0��7KH�*'�0�FDQ�VWRUH�XS�WR�
WKLV�QXPEHU�RI�ORJ�HQWULHV�EHIRUH�LW�RYHUZULWHV�WKH�EXIIHU��$Q�HQTXLU\�LV�PDGH�WR�WKH�
*'�0�HYHU\�VHFRQG��VR�LI�WKLV�LV�VHW�WR������*'�:RUNVKRS�FDQ�UHFHLYH�D�PD[LPXP�RI�
����QHZ�PHVVDJHV�HYHU\�VHFRQG�
1RWH��&XUUHQWO\�WKH�PD[LPXP�QXPEHU�RI�PHVVDJHV�WKH�ORJ�FDQ�UHSRUW�LV���.��DW�
ZKLFK�SRLQW�LW�EHJLQV�WR�RYHUZULWH�WKH�ROG�PHVVDJHV�

$XWR�(PXODWH 7KLV�OHWV�\RX�VSHFLI\�D�SURMHFW�ZKLFK�WKH�*'�0�ZLOO�DXWRPDWLFDOO\�HPXODWH�RQ�VWDUW�
XS��&KHFN�WKH�$XWR�(PXODWH�EXWWRQ�DQG�EURZVH�IRU�WKH�QDPH�RI�WKH�HPXODWLRQ�ILOH�RU�
FKHFN�/DVW�HPXODWLRQ�
6HH�DOVR�$XWR�HPXODWLQJ�D�&'�
�
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I IDs.
&RQILJXULQJ�DGGLWLRQDO�6&6,�GHYLFHV

If you have more than one CD writer or an additional emulation drive attached to the SCSI b
the back of the Katana development box, use this dialog box to select the devices you want 

1) Select SCSI Bus from the Configuration menu.

2) Any available devices attached to the Katana development box SCSI bus are sh
connected to the GD-M in the tree.

The active SCSI bus is shown in bold.

3) Highlight the device you want to use and click Select.

4) Click OK and reboot both the Katana development box and the development 
computer.

The GD-M will use the devices you selected as the default devices until you return to this dialo
make a new selection.

The internal emulation drive is preset to SCSI ID 0 and the GD-M’s initiator ID is set to SCSI 
on the SCSI bus. Any additional devices you connect to the SCSI bus must be configured with
IDs between 1 and 6. All devices on the SCSI bus must have different SCSI IDs.

Refer to the Katana development box Installation Manual for details of how to configure SCS
��
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&RQILJXULQJ�GHYLFH�GULYH�OHWWHUV

If there is more than one Katana development box or removable hard drive attached to the 
development system. GD Workshop will automatically display the Confogure Drive Letters di
box.

127(�127(� 8QGHU�VRPH�RSHUDWLQJ�V\VWHPV�DQG�FRQILJXUDWLRQV��*'�:RUNVKRS�FDQ�DVVLJQ�GULYH�OHWWHUV�

DXWRPDWLFDOO\�DQG�\RX�ZLOO�QRW�VHH�WKLV�GLDORJ�ER[�

To assign a drive letter to an emulator:

1) Select an emulator in the tree.

2) Select an available drive letter in the drop down box and click Add.

The emulator is assigned to the drive letter and added to the list of Current drive selections. T
emulators added to this list appear in the Control toolbar in GD Workshop so that you can choo
one you want to use at the time of emulation.

,PSRUWDQW�QRWH

If a particular device is not shown in the drop down box or the list of Current drive selections,
you know the device is connected to the development computer, check the following:

• The drive has been correctly formatted.

• The operating system of the drive is compatible with the operating system of the 
development computer.

• The drive is connected correctly.

• The SCSI IDs are correctly configured and the SCSI bus is correctly terminated.
��
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• On the Help menu click About Workshop to see the current firmware and software
versions.

Upgrades to the GD-M firmware are available from Sega DTS, contact technical support for d

To install the new firmware:

1) Copy the new firmware (*.FSH) to a local drive on the development system.

2) Select Update Firmware on the Configuration menu.

3) Browse for the new version of the firmware on the development system.

4) Click Open to overwrite the current GD-M firmware with this version.
��
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+RZ�WR�XVH�WKLV�KHOS�V\VWHP�DQG�JHW�WHFKQLFDO�VXSSRUW

For help when you are using GD Workshop, press F1 or click Help at the bottom of each tab wi
The relevant topic will be displayed. Alternatively, click the Help menu and select the help topic
want from the contents list.

In this Help system we provide details about the part of the interface you are in. We also try to
you guidance about what a particular item means, what information is being asked for and w
options you should select.

GD Workshop is intended to make it easier for you to prepare your CD projects. You will find 
Help system is a useful source of background information if you are unfamiliar with CDs and 
their content is written, however, to fully understand the various CD formats and the complex i
involved in their preparation, we recommend that you do some background reading to familia
yourself with current standards and specifications. See the section on reference documents at
of this manual.

7HFKQLFDO�VXSSRUW

Technical support is available from Sega DTS.
��
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This chapter describes the basics of using GD Workshop and how to use it to develop a typic
project.
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6R��ZKHUH�GR�,�VWDUW"

Once GD Workshop is installed and a Katana development box is connected to your develop
computer, you are ready to start creating a CD project.

The main functions and screen layout of GD Workshop are shown below.

The interface includes the usual Windows® 95 features and all the main functions can be drive
toolbars, menus, right-click menus, or keyboard short-cuts.

Project window

This area shows a 
tree 
representation of 
the content of 
your project. You 
can add files to 
the tree by 
dragging them 
onto the tree at 
the appropriate 
node from 
another program 
such as 
Windows® 
Explorer. You can 
also use the 
Project toolbar or 
the right-click 
menu.

Control window

This area enables you to control and log events on 
the GD-M. You can instruct the GD-M to emulate or 
write a CD from the toolbar and the results are 
logged in the window.

Tab controls

This area lets you
edit the attributes
of tracks and files
on the CD. When
you select a 
branch of the tree
in the project 
window, the 
relevant tab 
appears and you
can edit its 
attributes.
��
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The basic idea is that you add your prepared source files to the tree in the project window. Th
shows a hierarchical representation of the tracks and files which form the content your CD. Yo
edit the tree to change the order that the files are arranged on the CD, and when you are hap
the arrangement, emulate the CD.

If the emulation shows errors or running problems, you can make further edits to the tree or 
source files and repeat the process until you are satisfied with the emulation results.

The flowchart shows a typical project using GD Workshop to produce a tested CD-R master 
which you can press silver CDs. All of the main tasks can be done from within the GD Works
interface.

If you have a compatible CD writer you can write a CD-R directly from the Katane developm
box.

11227(�7(� *'�:RUNVKRS�FXUUHQWO\�VXSSRUWV�<DPDKD�&'(�&'5���������&'5���������DQG�&5:������

�����ZULWHUV�IRU�FRQYHQWLRQDO�&'�520�DQG�6HJD�*'%�IRU�*'�520��&RQWDFW�WHFKQLFDO�VXSSRUW�IRU�D�

OLVW�RI�FXUUHQWO\�VXSSRUWHG�&'�ZULWHUV�
��
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This chapter takes you through all the stages invovled in creating a CD project.

It has the following sections:

• Starting and saving a new project

• Adding tracks and files using toolbar buttons (slow)

• Adding tracks and files using drag and drop (quick).
���
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6WDUWLQJ�D�SURMHFW

To start a new project:

1) Click New on the File/Edit toolbar or select New on the File menu.

2) Name your project and click OK.

An empty project window is created where you can begin to add CDs, tracks and file
build up the content of your project.

6DYLQJ�D�SURMHFW

To leave a project and save your work:

1) Click Save on the File/Edit toolbar or select Save on the File menu.

If it is a new project, a standard Save As dialog box appears.

2) Choose the location where you would like to save the project and click Save.

The project is saved in a file with the extension .cpj. The .cpj file contains all the curr
information about the project so that you can pick up where you left off when you next 
the project.

11227(�7(� 3URMHFW�ILOHV���FSM��VKRXOG�EH�VDYHG�RQ�WKH�GHYHORSPHQW�FRPSXWHU��WKH\�0867�127�EH�VDYHG�

RQ�WKH�HPXODWLRQ�GULYH�RU�WKH�HPXODWLRQ�ZLOO�IDLO�
��
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With this method you add content to your project one item at a time:

• add a CD
• add a session
• add a track
• add a file
• add another file, and so on....

It is methodical but gives a good insight into how the hierarchy on a CD is structured.

$GGLQJ�D�&'

Once you have created a new project:

1) Click Add CD on the Project toolbar or use the right-click menu in the project wind

2) Select the type of CD you want to create: Audio, Data or GD-ROM and click OK

127(�127(� ,I�\RX�FKRRVH�$XGLR�\RX�FDQ�RQO\�DGG�&'�'$�WUDFNV�WR�WKH�&'��,I�\RX�FKRRVH�*'�520�\RX�

PXVW�PDNH�D�WZR�VHVVLRQ�*'�520�

&UHDWLQJ�D�PXOWLSOH�&'�VHW

You can add more than one CD to a project if you want to create a multiple CD set. As you ad
to the project they are labelled DISC1, DISC2, DISC3 and so on. You can edit these names o
Disc tab.

You can have as many CDs in a project as you like but you are limited by the capacity of the 
emulation drive, althuogh you can add an additional external hard drive for extra capacity if req
See also Using an external hard drive.

$GGLQJ�D�VHVVLRQ

If you are creating a conventional CD you add the content in a single session.

If you specified GD-ROM when you created the CD, you must make a two session GD-ROM
first session is the single density area and the second session is the high density area.

To add a session to the CD:
��
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1) Click Add Session on the Project toolbar or use the right-click menu in the proje
window.

2) Specify the type of file naming system for the session by clicking Add ISO Leve
Level 2 on the Project toolbar. See also File naming conventions and restriction

Once you have specified the file naming system, a symbol appears under the Session symb
forms the basis of your project and you can start to add tracks and files to the CD.

$GGLQJ�D�WUDFN

Before you can add data to a CD you must add one or more tracks where the data can be re

To add a track:

• Click the appropriate Add Track button on the Project toolbar or use the right-click m
in the project window.

11227(�7(� $�WUDFN�PXVW�FRQWDLQ�DW�OHDVW�IRXU�VHFRQGV�RI�GDWD�

The following rules apply:

&'�520

A conventional CD-ROM can contain up to 99 tracks consisting of multiple Mode 1 a
Audio tracks. The Audio tracks are always placed after the Mode 1 tracks.

*'�520

The first session on a GD-ROM (the single density area) always contains one Mode 1
followed by one Audio track.

The second session on GD-ROM (the high density area) can contain up to 99 Mode
Audio tracks.

3DGGLQJ�D�0RGH���WUDFN�WR�WKH�HQG�RI�WKH�GLVF
��
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In the second session of a GD-ROM, a Mode 1 track can follow an Audio track, so tha
Mode 1 track containing the game can be placed at the outside edge of the CD wher
disc speed is faster. The audio track that precedes it becomes a padding track conta
zero data.

To do this:

1) Add an Audio track to the second session in the tree.

2) On the Digital Audio tab for this track, check Pad to end of disc.

3) Add the Mode 1 track that contains the game after the Audio padding tra

The size of the Audio padding track is automatically calculated so that the Mode 1 tra
placed at the outside edge of the CD.

The padding track can be seen as an Audio track in the tree, but it cannot be played
also Track Types.

$GGLQJ�D�GLUHFWRU\

You can add files directly to the tracks in the tree or you can organise files into directories.

To add a directory:

1) Select the track where you want to add a directory.

2) Click Add Directory on the Project toolbar or use the right-click menu in the proje
window.

3) Name the directory and click OK.

A directory symbol appears in the project tree and you can add files to it.

127(�127(� 7KH�PD[LPXP�QXPEHU�RI�ILOHV�WKH�*'�0�FDQ�HPXODWH�LV��������

$GGLQJ�D�ILOH

To add a file:

1) Select the track or directory where you want to add a file.

2) Click Add File on the Project toolbar or use the right-click menu in the project wind
��
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3) Browse for the file you want to add to the project and click Open.

11227(�7(� 7KH�PD[LPXP�QXPEHU�RI�ILOHV�WKH�*'�0�FDQ�HPXODWH�LV��������

When you add a file to the project the following happens:

• A File Copier progress window appears and the file is copied to the GD-M’s emula
drive where it will be accessed later during emulation. If the file is small the progre
window will be shown very briefly.

• The file is added to the tree in the project window.

You may notice that the file name in the tree has been shortened. This happens if the name 
source file does not comply with the file naming system that you specified for the CD.

See also Keeping track of file versions, File naming conventions and restrictions and How and
to use small file archives.
��
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$GGLQJ�WUDFNV�DQG�ILOHV�XVLQJ�GUDJ�DQG�GURS��TXLFN�

With this method you add content to your project in a single drag and drop operation. It requires
preparation, but once your source files and GD Workshop are set up it is very quick.

The basic method is:

• Set up your source files on the development computer.
• Set up a new project.
• Drag and drop the source files into GD Workshop.

6HW�XS�\RXU�VRXUFH�ILOHV

Arrange your source files in the root directory of the development computer in the way you w
them to appear on the CD.

1) If you want to group a set of files in a directory on the CD, place them in a direct
on the development computer.

2) Give your files and directories meaningful names now to avoid editing them later.
also Relative paths and File naming conventions and restrictions.

127(�127(� 7KH�PD[LPXP�QXPEHU�RI�ILOHV�WKH�*'�0�FDQ�HPXODWH�LV��������

127(�127(� <RX�FDQQRW�PRYH�PRUH�WKDQ�������ILOHV�LQ�D�VLQJOH�GLUHFWRU\��,I�\RX�QHHG�WR�FUHDWH�D�GLUHFWRU\�

RQ�WKH�&'�ZKLFK�FRQWDLQV�PRUH�WKDQ�������ILOHV��\RX�PXVW�GUDJ�LQ�VHSDUDWH�GLUHFWRULHV�RI�������ILOHV�

HDFK��7KHQ��E\�UHQDPLQJ�WKH�GLUHFWRULHV�LQ�*'�:RUNVKRS��\RX�FDQ�PRYH�DOO�WKH�ILOHV�LQWR�WKH�VDPH�

GLUHFWRU\�RQ�WKH�&'�

6HW�XS�D�QHZ�SURMHFW

1) In GD Workshop, click New.

2) Name the project and click OK.

An empty project window is created.

3) Select Workshop on the Configuration menu.

4) Under Initial Track Type select the type of track that you want to create first on the

For example, if your source files are CD-ROM data you would select Mode 1 as your in
track type.

5) If you are creating a GD-ROM:
��
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• and you want to add the files to the second session (the data session), c
GD-ROM auto-build, add files to 2nd session.

• and you want to add the files to the first session (the message session),
uncheck GD-ROM auto-build, add files to 2nd session. See also GD-RO
layout and sector addresses.

6) Click OK..

'UDJ�DQG�GURS�WKH�VRXUFH�ILOHV

1) Browse the development computer for the source files you want to put on the C

2) Select all the source files and drag them into the empty project window. If your so
files are grouped together in a directory, just select the directory and drag it into
project window.

GD Workshop looks at the files you are copying and makes a decision about the file na
system to use on the CD. The File Systems Configuration dialog box appears so tha
can confirm or change the file naming system. See also File naming conventions an
restrictions.

3) Confirm or change the file naming system to use on the CD:

When you have confirmed the file naming system the following happens:

• A File Copier progress window appears and the source files are copied to the emu
drive where they will be accessed later during emulation.

• A tree is drawn in the project window to represent the content of the CD.

11227(�7(� <RX�PD\�QRWLFH�WKDW�WKH�ILOH�QDPHV�LQ�WKH�WUHH�KDYH�EHHQ�VKRUWHQHG��7KLV�KDSSHQV�LI�WKH�

QDPH�RI�WKH�VRXUFH�ILOH�GRHV�QRW�FRPSO\�ZLWK�WKH�ILOH�QDPLQJ�V\VWHP�WKDW�\RX�VSHFLILHG�IRU�WKH�&'�
��
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a CD 
This chapter takes you through the various ways you can edit and re-arrange the content of 
project.

It has the following sections:

• Getting project information

• Finding files in a large project

• Adding and deleting tracks and files

• Renaming files and directories

• Keeping track of file versions

• Copying and moving files.
���
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At any time during the project you can get extensive information about the content of your pr
by clicking Project Information on the File menu.

)LQGLQJ�ILOHV�LQ�D�ODUJH�SURMHFW

The Navigation toolbar shown here has buttons to collapse and expand the tree in the projec
window. It also allows you to switch between tree view and list view.

To find files in a large project:

1) Click Find Files.

The Find Files dialog box appears.

2) Enter the name (or part of a name) you want to look for and click Find First or F
Next.

GD Workshop highlights any occurrence of that name in the tree.

11227(�7(� <RX�FDQ�UHSHDW�ILQG�RSHUDWLRQV�DW�D�ODWHU�GDWH�ZLWKRXW�KDYLQJ�WR�UH�HQWHU�WKH�ILOH�QDPH�E\�

XVLQJ�WKH�)LQG�)LOHV�KLVWRU\�OLVW�
��
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$GGLQJ

At any time you can add a track or file to your project:

1) Select the place in the project tree where you want to add the item.

2) Click the relevant Add button on the Project toolbar, the right-click menu in the pro
window or the Insert option on the Edit menu.

127(�127(� <RX�FDQ�DOVR�GUDJ�LWHPV�GLUHFWO\�RQ�WR�WKH�SURMHFW�WUHH�DW�WKH�DSSURSULDWH�SODFH��<RX�FDQQRW�

FRS\�DQG�SDVWH�LWHPV�LQWR�WKH�WUHH�IURP�RWKHU�DSSOLFDWLRQV��RQO\�GUDJ�DQG�GURS�LV�YDOLG�

'HOHWLQJ

To delete an item from the tree

• Select it and then click Delete on the Project toolbar, the right-click menu in the pro
window or the Delete key on your keyboard.

If you delete something by mistake click Undo on the Project toolbar. There is no limit to the nu
of undo operations. If you have deleted several items from the tree and you want to bring the
back in one operation, click the Undo All option on the Edit menu.
��
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It is best to give your files and directories correct ISO9660 compliant names on the developm
computer before you add them to the CD.See also File naming conventions and restrictions.

However, if you need to edit file and directory names after they have been added, there are 
ways to do this.

11227(�7(� <RX�FDQQRW�KDYH�WZR�ILOHV�ZLWK�WKH�VDPH�QDPH�LQ�WKH�VDPH�GLUHFWRU\��6LPLODUO\��\RX�FDQQRW�

KDYH�WZR�GLUHFWRULHV�ZLWK�WKH�VDPH�QDPH�DW�WKH�VDPH�OHYHO�

5HQDPLQJ�ILOHV

• using the File Name tab:

1) In the project tree select the file you want to rename.

2) In the File Name tab type over the old file name and click Apply.

• using the project tree:

1) In the project tree select the file you want to rename and press F2 or do
click on the file name leaving a pause between clicks.

2) Type over the old file name and press Enter on your keyboard or select 
different part of the tree. While you are typing over the name you can pr
ESC to cancel the operation.

11227(�7(� 7KHUH�LV�QR�8QGR�DIWHU�\RX�KDYH�W\SHG�RYHU�D�QDPH�LQ�WKH�WUHH��\RX�PXVW�UHQDPH�WKH�ILOH�RU�

GLUHFWRU\�DJDLQ�LI�\RX�PDNH�D�PLVWDNH�

5HQDPLQJ�GLUHFWRULHV

• using the File Name tab:

1) In the project tree select the file who’s directory you want to rename.

2) In the File Name tab type over the old directory name and click Apply.

This will make a new path to the selected file only, all other files will still have the sam
path. This can be seen in the tree.

• using the Directory tab:
��
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1) In the project tree select the directory you want to rename.

2) In the Directory tab type over the old directory name and click Apply.

This will make a new path to the selected directory only, all other sub-directories will 
have the same path.

• using the project tree:

1) In the project tree select the directory you want to rename and press F2
double click on the directory leaving a pause between clicks.

2) Type over the old directory name and press Enter on your keyboard or s
a different part of the tree.

This will make a new path to the selected directory and all its sub-directories.
��
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To check the status of the files at any time while you are working on a project:

• Select Check File Versions on the File Menu.

11227(�7(� <RX�FDQ�DOVR�WHOO�*'�:RUNVKRS�WR�DXWRPDWLFDOO\�SHUIRUP�D�FKHFN�HDFK�WLPH�\RX�RSHQ�D�

SURMHFW�LI�\RX�VHOHFW�&KHFN�IRU�XSGDWHG�ILOHV�LQ�WKH�:RUNVKRS�6HWWLQJV�GLDORJ�ER[�RQ�WKH�&RQILJXUDWLRQ�

PHQX�

When it performs a version check, GD Workshop looks at the source files for the project on t
development computer and the same files on the emulation drive. The version numbers and
modification date of corresponding files are compared. If differences are detected a dialog b
appears showing the status of the files.

There are three ways to update the files:

• Cancel, to leave everything as it is.
• Update to emulator, if you have edited a source file on the development computer

not updated the file on the GD-M.
• Restore from emulator, if you have edited or deleted a source file on the developm

computer and you want to restore it with the version that is on the GD-M.

11227(�7(� 7R�GR�D�OLQN�FKHFN�*'�:RUNVKRS�PXVW�NQRZ�ZKHUH�WKH�HPXODWLRQ�ILOHV�DQG�WKH�VRXUFH�ILOH�

DUH�ORFDWHG��7KLV�LQIRUPDWLRQ�LV�ZULWWHQ�LQWR�WKH�SURMHFW�DV�\RX�DGG�LWHPV�WR�LW��,I�\RX�PRYH�DQ\�RI�WKH�

ILOHV��IRU�H[DPSOH��LI�\RX�FKDQJH�WKH�GULYH�OHWWHU�RI�WKH�GHYHORSPHQW�FRPSXWHU��WKH�OLQN�FKHFN�ZLOO�IDLO�

XQOHVV�\RX�FRPSOHWHO\�UHEXLOG�WKH�SURMHFW�
��
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There are two views in which you can see the content of your CD in the project window; Tree
and List view. You can switch between these two views on the View menu or by clicking Swit
Views on the Navigation toolbar.

• Tree view

In tree view the hierarchy of the CD is shown and you can see the full structure of 
directories, tracks and file systems.

In this view you can add and delete files, directories and tracks. You can also move f
between directories and tracks or between different CDs in a multiple CD project.

• List view

In list view, the files are shown in the actual order that they are written in each file sys
on the CD (Level 1 or Level 2). Only one file system is shown at a time, to view anoth
file system return to tree view, select another file system and return to list view.

When you select a file in list view, its exact position is given on the File Name tab wh
the start sector and end sector are shown. You can move and copy files within the file s
in list view but you cannot add or delete files.

127(�127(� :KHUH�WZR�DGMDFHQW�ILOHV�LQ�OLVW�YLHZ�DUH�RQ�GLIIHUHQW�WUDFNV��WKHUH�LV�D�JDS�RI�����VHFWRUV�

VHSDUDWLQJ�WKH�ILOHV��7KLV�LV�WKH�SUH�RU�SRVW�JDS�RI�WKH�WUDFN�ZKLFK�LV�DXWRPDWLFDOO\�JHQHUDWHG�E\�*'�

:RUNVKRS�

6HOHFWLQJ�ILOHV�DQG�GLUHFWRULHV

You select items in GD Workshop using standard windows techniques. A selected item is sho
highlighted in the project window.
6LQJOH�FOLFN
VHOHFWV�D�VLQJOH�LWHP�

6KLIW�FOLFN VHOHFWV�HYHU\WKLQJ�EHWZHHQ�WZR�SRLQWV�

&RQWURO�FOLFN VHOHFWV�PXOWLSOH�LWHPV�

6KLIW�XS�GRZQ�DUURZ ZDONV�WKURXJK�WKH�WUHH�DW�WKH�FXUUHQW�OHYHO�VHOHFWLQJ�HYHU\WKLQJ�DW�WKDW�OHYHO�DQG�
EHQHDWK�LW�

0RYLQJ�DQG�FRS\LQJ�ILOHV�DQG�GLUHFWRULHV <RX�PRYH�DQG�FRS\�LWHPV�LQ�*'�:RUNVKRS�XVLQJ�VWDQGDUG�ZLQGRZV�WHFKQLTXHV��
7KHUH�LV�QR�XQGR�IRU�WKH�RSHUDWLRQV�EHORZ�
��
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11227(�7(� &XW�FRS\�DQG�SDVWH�RQO\�ZRUN�ZLWKLQ�*'�:RUNVKRS��<RX�FDQQRW�GR�FXW�FRS\�DQG�SDVWH�IURP�

DQRWKHU�DSSOLFDWLRQ�LQWR�*'�:RUNVKRS��RQO\�GUDJ�DQG�GURS�LV�YDOLG�

'UDJ�DQG�GURS PRYHV�WKH�VHOHFWHG�LWHPV�

&RQWURO�GUDJ�DQG�GURS FRSLHV�WKH�VHOHFWHG�LWHPV�

&XW�DQG�SDVWH PRYHV�WKH�HOHFWHG�LWHPV�

&RS\�DQG�SDVWH FRSLHV�WKH�VHOHFWHG�LWHPV�
��
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This chapter takes you through the stages involved in emulating and testing a CD project.

It has the following sections:

• Emulating a CD

• Emulating errors on a CD

• Auto-emulating a CD

• Reading the log information.
���
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11227(�7(� ,I�\RX�DWWHPSW�WR�DFFHVV�WKH�HPXODWLRQ�GULYH�GXULQJ�DQ�HPXODWLRQ��\RX�ZLOO�VHH�WKH�PHVVDJH�

§$FFHVV�GHQLHG��GHYLFH�QRW�UHDG\¨�

When you are happy with the arrangement of the content of your CD and you want to test th
works:

1) Switch the Emulator/GD-Drive switch on the control toolbar to Emulator (up 
position).

2) Select the emulator you want to use in the drop down list in the control toolbar (
if you have more than one emulator connected to the development computer).

3) If your project consists of several CDs, select which CD you want to emulate in 
drop down list in the control toolbar. You can only emulate one CD at a time.

4) Click Close Door on the control toolbar.

11227(�7(� 7KH�DERYH�FRQWUROV�DUH�DOVR�DYDLODEOH�IURP�WKH�WDVN�EDU�XVLQJ�WKH�ULJKW�FOLFN�PRXVH�EXWWRQ�

ZKHQ�*'�:RUNVKRS�LV�PLQLPLVHG�

The GD-M now appears to the Katana development box or the target computer as a CD drive
is playing your “virtual” GD-ROM or CD.

To halt the emulation at any time click Open Door on the control toolbar.

You can make changes to your project and re-emulate as many times as you like until you a
completely satisfied that your CD has no running problems before you write a gold master. Se
Writing a CD-R.

6HOHFWLQJ�WKH�HPXODWLRQ�VSHHG

There are four settings of emulation speed.

To change the emulation speed:

1) Select Workshop on the Configuration menu.

2) In the drop down box select the emulation speed you want to use.
��
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With this set to Real Katana Speed, the GD-M will mimic a GD-ROM in a CAV machine where
data retrieval rate is 4x in the single density area (session one) and 6x at the inside edge of t
density area, increasing to 12x at the outside edge.

You can also set Real Katana Speed + or - 5%.

With the option set to No Speed Restrictions, the GD-M will emulate at full speed. Full speed i
or above depending on the complexity of the data.
��
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There are three types of errors which GD Workshop can add to test how errors affect the data 
CD:

• Hard errors

• Soft errors

• Nudge.

11227(�7(� %HIRUH�\RX�ZULWH�D�JROG�GLVF�DOZD\V�PDNH�VXUH�WKDW�DOO�HUURUV�DUH�GLVDEOHG�

+DUG�HUURUV

To add hard errors in a file, you specify sectors in the file that contain bad data. This mimics 
that has been recorded on bad media (a faulty or scratched CD) or sections of data that are 
for some other reason.

To specify a hard error:

1) Select the file in the tree where you want the error to be.

2) In the Hard Errors tab, specify the start sector of the error in the From box, and th
sector in the To box.

3) Click Add.

The error is added to the list on the Hard Errors tab.

4) Repeat these steps for all the errors you want to include in the file.

11227(�7(� 7KH�PD[LPXP�QXPEHU�RI�KDUG�HUURUV�\RX�FDQ�DGG�LV����SHU�SURMHFW�

Each file containing hard errors is indicated in the tree by , and hard errors can be switch
and off before or during emulation by clicking the Hard errors on/off button in the control tool

During emulation errors are shown in the log by a warning message which reports the numb
sectors which were not retrieved due to the error.
��
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127(�127(� ,I�\RX�HQDEOH�KDUG�HUURUV�GXULQJ�DQ�HPXODWLRQ��WKH�HUURUV�PLJKW�QRW�EH�HIIHFWLYH�LPPHGLDWHO\�

EHFDXVH�WKH�GDWD�EHLQJ�UHDG�IURP�WKH�HPXODWLRQ�PD\�DOUHDG\�EH�FDFKHG��)RU�ILOHV�ZKLFK�DUH�ODUJHU�

WKDQ�WKH�FDFKH�VL]H�DQG�ZKLFK�KDYH�VHYHUDO�KDUG�HUURUV��\RX�ZLOO�VHH�HUURUV�DIWHU�WKH�QH[W�UHDG�

FRPPDQG��

,I�\RX�HQDEOH�KDUG�HUURUV�EHIRUH�HPXODWLQJ�\RX�ZLOO�VHH�DOO�WKH�HUURUV�DV�WKH\�RFFXU�

6RIW�HUURUV

To add soft errors, you specify the ratio of good sectors to bad sectors for the whole CD. Soft
are introduced randomly by the emulator at the rate you specify.

To specify a soft error:

1) Click on the Soft Errors drop down box on the GD-M control toolbar.

2) In the drop down box select an error rate.

For example, 1 in 100 would introduce one bad sector in every one hundred sectors.

Soft errors can be switched on and off before or during emulation.

During emulation errors are shown in the log by a warning message which reports the numbe
sectors which were not retrieved.

127(�127(� ,I�\RX�HQDEOH�VRIW�HUURUV�GXULQJ�DQ�HPXODWLRQ��WKH�HUURUV�PLJKW�QRW�EH�HIIHFWLYH�LPPHGLDWHO\�

EHFDXVH�WKH�GDWD�EHLQJ�UHDG�IURP�WKH�HPXODWLRQ�PD\�DOUHDG\�EH�FDFKHG��)RU�ILOHV�ZKLFK�DUH�ODUJHU�

WKDQ�WKH�FDFKH�VL]H�DQG�ZKLFK�KDYH�D�KLJK�HQRXJK�VRIW�HUURU�UDWH��\RX�ZLOO�VHH�HUURUV�DIWHU�WKH�QH[W�

UHDG�FRPPDQG�

,I�\RX�HQDEOH�VRIW�HUURUV�EHIRUH�HPXODWLQJ�\RX�ZLOO�VHH�DOO�WKH�HUURUV�DV�WKH\�RFFXU�

1XGJH

A nudge error mimics what happens when someone nudges the CD player while playing the

To introduce a nudge:

• Click Nudge on the GD-M control toolbar while emulating the CD, or press “n” on th
keyboard.

127(�127(� 7KH�QXGJH�KDV�D�����VHFRQG�WLPHRXW��,I�WKHUH�LV�QR�UHDG�FRPPDQG�E\�WKH�HPXODWLRQ�ZLWKLQ�

����VHFRQGV�RI�FOLFNLQJ�1XGJH��WKH�QXGJH�LV�FDQFHOOHG�
��
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11227(�7(� ,I�\RX�QXGJH�WKH�&'�GXULQJ�DQ�HPXODWLRQ��\RX�PLJKW�QRW�VHH�WKH�HUURU�LI�WKH�GDWD�EHLQJ�UHDG�

IURP�WKH�HPXODWLRQ�LV�LQ�FDFKH��,I�\RX�QXGJH�ZKHQ�WKH�FDFKH�LV�HPSW\��\RX�ZLOO�VHH�WKH�HUURU�UHSRUWHG�

LQ�WKH�ORJ�

7KLV�PLPLFV�WKH�RSHUDWLRQ�RI�D�UHDO�&'�PHFKDQLVP�
��
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To auto-emulate a CD:

1) Select Hardware on the Configuration menu.

2) Check the Auto Emulate option.

3) Check Last Emulation or browse the emulation drive for the project you want to 
emulate and select the file with the .HCD extension.

4) Click Open.

127(�127(� 7KH�+&'�ILOH�LV�FUHDWHG�E\�*'�:RUNVKRS�ZKHQ�\RX�FOLFN�&ORVH�'RRU�LQ�WKH�FRQWURO�ZLQGRZ��

<RX�PXVW�GR�WKLV�ILUVW�ZLWK�WKH�*'�0�DWWDFKHG�WR�WKH�GHYHORSPHQW�FRPSXWHU�EHIRUH�\RX�FDQ�

DXWR�HPXODWH�WKH�&'��6HH�DOVR�)LOHV�JHQHUDWHG�E\�*'�:RUNVKRS�

With the GD-M set to auto-emulate, you can disconnect it from the development computer.

When the Katana development box is rebooted, the GD-M appears on the SCSI bus as a CD
with its door closed, playing the CD you specified in the Emulation Name box.

127(�127(� )RU�D�*'�520�WKH�.DWDQD�ORRNV�IRU�WKH�ILOH�ZKLFK�LV�DOSKDEHWLFDOO\�ILUVW�DQG�HPXODWHV�WKLV�

ILOH�
��
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5HDGLQJ�WKH�ORJ�LQIRUPDWLRQ

During emulation communications with the GD-M are shown in the control window of GD 
Workshop in a time stamped log. The log lets you see the status of the GD-M and any 
communications between it and the target computer or a CD writer.

A typical log message is shown below.

/RJ�PHVVDJH�GHILQLWLRQV

7LPH 7KLV�LV�WKH�WLPH�RI�WKH�PHVVDJH�DQG�LV�H[SUHVVHG�LQ�KRXUV��PLQXWHV��VHFRQGV�DQG�
PLOOLVHFRQGV�VLQFH�WKH�*'�0�ZDV�ODVW�ERRWHG��SRZHUHG�RII�DQG�RQ��

7\SH 7KLV�LV�WKH�W\SH�RI�PHVVDJH��ORJ��ZDUQLQJ�RU�HUURU�

*URXS 7KLV�LV�WKH�PHVVDJH�JURXS�

0HVVDJH 7KLV�LV�WKH�LQVWUXFWLRQ��UHTXHVW�RU�PHVVDJH�EHLQJ�SDVVHG�EHWZHHQ�WKH�*'�0�DQG�WKH�
WDUJHW�FRPSXWHU�RU�&'�ZULWHU��0RVW�RI�WKH�PHVVDJHV�DUH�VHOI�H[SODQDWRU\��WKH�OHVV�
REYLRXV�PHVVDJHV�DUH�GHILQHG�LQ�WKH�WDEOH�EHORZ�

3DUDPHWHU 7KLV�DGGV�YDOXH�WR�WKH�PHVVDJH��)RU�H[DPSOH��D�5($'�����LQVWUXFWLRQ�PXVW�DOVR�KDYH�
D�VHFWRU�DGGUHVV�IURP�ZKLFK�WR�VWDUW�UHDGLQJ�DQG�D�UHDG�OHQJWK�RI�Q�VHFWRUV��1RW�DOO�
ORJ�PHVVDJHV�KDYH�SDUDPHWHUV�

)LOH�QDPH 7KLV�LV�WKH�QDPH�RI�WKH�ILOH�EHLQJ�HPXODWHG�DW�WKH�WLPH�RI�WKH�PHVVDJH��1RW�DOO�
PHVVDJHV�KDYH�D�ILOH�QDPH�

/RJ�PHVVDJH 0HDQLQJ

,QTXLU\ 6&6,�EXV�VFDQ�WR�VHH�ZKDW�GHYLFHV�DUH�RQ�WKH�EXV�

5HDG6XE&KDQQHO 5HTXHVW�IRU�SRVLWLRQ�RI�&'�DQG�FXUUHQW�DXGLR�VWDWXV�

5HDG���� 5HDG�UHTXHVW�IRU�D�VSHFLILF�QXPEHU�RI�VHFWRUV�IURP�D�VSHFLILF�DGGUHVV�
��
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The log information can be used as a useful diagnostic tool to help you overcome running pro
due to badly positioned files on your CD.

For example, if your CD project shows unacceptable pauses when moving between certain file
can see from the log which files the GD-M is trying to read when pauses occur. You can optim
performance by positioning the files which cause the problem closer together.

Using the right-click menu in this region you can:

• Save the log to a text file by clicking Save to File.
• Continuously write the log to a text a file by clicking Start File Logging and then sa

this file by clicking Stop File Logging.
• Switch off the log display completely by clicking Display Logging.

0RGH6HQVH��� 5HTXHVW�IRU�GULYH�SDUDPHWHUV�RI�WKH�&'�HPXODWLRQ�GULYH�VXFK�DV�GULYH�VSHHG�

0RGH6HOHFW��� ,QVWUXFWLRQ�WR�FKDQJH�WKRVH�SDUDPHWHUV�DERYH�ZKLFK�FDQ�EH�FKDQJHG�

6HHN���� ,QVWUXFWLRQ�WR�JR�WR�VHFWRU�Q�RU�DGGUHVV�PP�VV�II�

5HDG72& 5HDG�UHTXHVW�IRU�7DEOH�RI�&RQWHQWV�RI�WKH�&'�

5HDG&'&DSDFLW\ 5HTXHVW�IRU�FDSDFLW\�RI�GDWD�RQ�WKH�&'�

3OD\$XGLR06) 3OD\�WUDFN�IURP�PP�VV�II�WR�PP�VV�II�

3OD\$XGLR���� 5HDG�����IRU�DQ�DXGLR�&'�

/RJ�PHVVDJH 0HDQLQJ
��
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This chapter takes you through the stages involved in writing a gold master CD from te Kata
development box.

It has the following sections:

• Writing a CD-R

• Switching between different CD writers.
���
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127(�127(� ,I�\RX�DWWHPSW�WR�DFFHVV�WKH�HPXODWLRQ�GULYH�ZKLOH�ZULWLQJ�D�&'�5��\RX�ZLOO�VHH�WKH�PHVVDJH�

§$FFHVV�GHQLHG��GHYLFH�QRW�UHDG\¨�

127(�127(� *'�:RUNVKRS�FXUUHQWO\�VXSSRUWV�<DPDKD�&'(�&'5���������&'5���������DQG�&5:������

�����ZULWHUV�IRU�FRQYHQWLRQDO�&'�520�DQG�6HJD�*'%�IRU�*'�520��&RQWDFW�WHFKQLFDO�VXSSRUW�IRU�D�

OLVW�RI�FXUUHQWO\�VXSSRUWHG�&'�ZULWHUV�

You can write a CD-R directly from the GD-M with a compatible CD writer connected to the Kat
development box SCSI bus.

There are two Write buttons on the toolbar in the control window, Test Write and Write.

7HVW�:ULWH

We recommend that before you write a CD-R, you carry out a test write to make sure
there are no communication problems between the GD-M and the CD writer. To do th

1) Click Test Write.

2) In the Test Write progress box select the writing speed and click OK.

A test write is exactly the same as an actual write, except that the laser in the CD wr
disabled so that a CD-R is not wasted if there is a problem.

If the test write is successful, a confirmation message appears in the control window.

:ULWH

To repeat the process and write a CD-R with the laser enabled click Write.

6ZLWFKLQJ�EHWZHHQ�GLIIHUHQW�&'�ZULWHUV

If you have more than one CD writer connected the Katana development box SCSI bus, sele
one you want to use as follows:

1) Select SCSI Bus from the Configuration menu.

2) The available CD-Rs attached to the Katana development box SCSI bus are sho
connected to the GD-M in the tree.
��
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al 
3) Highlight the device you want to use and click Select.

4) Click OK and reboot both the Katana development box and the development 
computer.

Refer to the Katana development box Installation Manual for details of how to connect extern
devices.
��
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This chapter describes the benefits which can be gained by using an addition emulation driv

It has the following sections:

• Using an external hard drive

• Formatting the emulation drive

• Fragmentation of the emulation drive
���
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Attaching an external hard drive to the Katana development box SCSI bus provides the follo
advantages:

• It allows you to easily switch between projects by keeping your projects on separa
drives.

• It allows you to increase the capacity of a project.

In a multiple CD project, you can place the content of several CDs on a single drive if there i
sufficient capacity, but you cannot have a single CD whose files are spread across different 
emulation drives. The GD-M can only emulate from files on one drive at a time.

Refer to the Katana development box Installation Manual for details of how to connect extern
devices.

6ZLWFKLQJ�EHWZHHQ�GLIIHUHQW�HPXODWLRQ�GULYHV

If you have more than one emulation drive connected the Katana development box SCSI bus
the one you want to use as follows:

1) Select SCSI Bus from the Configuration menu.

The available drives attached to the Katana development box SCSI bus are shown 
connected to the GD-M in the tree.

2) Highlight the device you want to use in the tree and click Select.

3) Click OK and reboot both the Katana development box and the development 
computer.
��



*'�:RUNKRS�8VHU�*XLGH

lways 
TFS 

ation 

n.

 to 
)RUPDWWLQJ�WKH�HPXODWLRQ�GULYH

Whatever size emulation drive is fitted in the Katana development box when it is shipped, it is a
formatted with a 2 GB FAT16 partition so that it is compatible with Windows 95, OSR2 and N
operating systems.

If you want to add an external drive for extra capacity or reformat the internal drive, the emul
drive must be formatted with a cluster size of 32K or above.

127(�127(� ,I�WKH�HPXODWLRQ�GULYH�LV�IRUPDWWHG�ZLWK�D�FOXVWHU�VL]H�VPDOOHU�WKDQ���.��WKH�*'�0�ZLOO�QRW�

HPXODWH�

127(�127(� ,I�\RX�DUH�UXQQLQJ�*'�:RUNVKRS�RQ�:LQGRZV�����QRQ�265����\RX�FDQ�RQO\�IRUPDW�WKH�

HPXODWLRQ�GULYH�XVLQJ�)$7���ZLWK�D�PD[LPXP���*%�SDUWLWLRQ�VL]H��UHJDUGOHVV�RI�WKH�VL]H�RI�WKH�

HPXODWLRQ�GULYH�

7R�IRUPDW�WKH�HPXODWLRQ�GULYH�ZLWK�17)6�XQGHU�:LQGRZV�17�
RSHUDWLQJ�V\VWHP�

1) On the Start menu select Programs > Administrative Tools > Disk Administrator.

2) In Disk Administrator select the emulation drive you want to format.

3) On the Partition menu select Delete and answer Yes to delete the current partitio

4) On the Partition menu select Create.

5) Enter the size of the new partition you want to create, click OK, and answer Yes
create a new partition.

6) On the Partition menu select Commit Changes Now and exit Disk Administrator.

7) On the Start menu select Programs > Command Prompt.

8) At the Command Prompt use the following command line:

format [drive letter]: /fs:ntfs /a:32k

where:

/fs is the switch to set the file system

/a is the switch to set the cluster size

32K = cluster size.

9) Press Enter to start formatting.
��
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7R�IRUPDW�WKH�HPXODWLRQ�GULYH�ZLWK�)$7���XQGHU�:LQGRZV����265��

RSHUDWLQJ�V\VWHP�

1) In GD Workshop select Hardware from the Configuration menu.

2) Uncheck the Drive Removable option.

3) In Windows set the emulation drive to fixed:

• right-click My Computer,

• select Properties,

• select Device Manager,

• under Disk Drives double click the emulation drive you want to format,

• select Settings and uncheck Removable.

4) Reboot the development computer.

5) In a DOS box use FDISK or AFDISK to create a partition of the required size.

6) Reboot the development computer.

7) In a DOS box use the following command line to format the drive:

format [drive letter]: /z:64

where:

/z is an undocumented switch to set the number of sectors per cluster

64 sectors of 512 bytes = 32K cluster size.

8) When formatting is complete, reset the drive properties in Windows to Removable
step 3 above.

9) Reboot the development computer.

10) Start GD Workshop and reset the drive properties to Removable, see steps 1 an
above.

)UDJPHQWDWLRQ�RI�WKH�HPXODWLRQ�GULYH

If the emulation drive becomes severely fragmented emulation can become unreliable. We 
recommend that you occasionally defragment the emulation drive.
��
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This chapter describes the way content CD is written on a CD and the various different forma
available and their restrictions. It also describes any perculiarities involved in preparing a Se
GD-ROM and using GD Workshop.

It has the following sections:

• The capacity of a CD project

• CD layout and sector addresses

• GD-ROM layout and sector addresses

• Track typess

• Relative paths

• File naming conventions and restrictions

• Permitted ISO9660 characters

• Files generated by GD Workshop

• How and when to use small file archives.
���
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A GD-ROM has 1.2 GB capacity and a conventional CD has 650 MB capacity.

The number of GD-R or CD projects you can work on at one time depends on the capacity o
emulation drive, but you can connect additional hard drives to the Katana development box S
bus for extra capacity. See also Using an external hard drive.

There must also be some capacity on the GD-M for emulation files created by Workshop. Th
depends on the information you are recording but can be as much as 5 MB for a CD which co
a large number of files.

11227(�7(� 7KH�PD[LPXP�QXPEHU�RI�ILOHV�WKH�*'�0�FDQ�HPXODWH�LV��������
��
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The diagram below shows the basic layout of the content of a GD-ROM. The content is writte
single, continuous, spiral track that starts at the centre of the disc and reads outwards.

A GD-ROM always contains a single density area and a high density area.

6LQJOH�GHQVLW\�DUHD

This has the same layout as a conventional CD, except that it has approximately 35 
capacity.

User data and audio is written in the program area which contains one data and one
track. This area can be read by a PC and is used to record a message which is displ
the user tries to play the GD-ROM in a standard CD drive.

+LJK�GHQVLW\�DUHD

This is located after the lead-out of the single density area and starts with a second V
A-time 10:00:00.

The high density area is where the game is written and can contain up to 99 Mode 1
CD-DA tracks. It is possible to have a Mode1 track following a CD-DA track in this form
��
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A GD-ROM is played in a constant angular velocity (CAV) machine which means that
speed at the inside edge of the disc is slower than at the outside edge. Therefore, th
speed (and data retrieval rate) of the high density area is 6x at the beginning increas
12x at the end.

6HFWRU�DGGUHVVHV�RQ�D�&'��PP�VV�II�

Sector positions on a CD are expressed as absolute or relative time in minutes, seconds and
(a frame is the same as a sector) in the format mm:ss:ff (also written as MSF). They can also
expressed as a sector number.

$EVROXWH�WLPH

This is the position of a sector relative to the absolute time at the beginning of the CD
disadvantage of using this system is that if you edit a track or file at the beginning of
CD so that it becomes longer or shorter, the absolute times for each subsequent sec
data will change and must be recalculated.

5HODWLYH�WLPH

This is the position of a sector relative to some other point on the CD such as the beg
of a track, file or extent (an extent is a specified number of sequential blocks on the 
It is more convenient to use relative time because if changes are made in track one 
example, only the addresses of sectors in track one are affected, the start times of a
subsequent tracks will change but the relative times within each track remain the sa

6HFWRU�QXPEHU

Often only the sector number is given in a seek or read command or to express the 
address of a file on a CD. For this purpose sectors are counted from the first sector 
first track which is sector zero. Each sector increments by one up to n depending on
much data the CD holds.
��
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The diagram below shows the basic layout of the content of a CD. The content is written in a s
continuous, spiral track that starts at the centre of the CD and reads outwards.

A CD always starts with a lead in area which contains the Table of Contents (TOC). The TOC
contains information about the tracks on the CD and their running order.

Following the lead-in, and always starting at sector 00:02:16, is the Volume Descriptor Set (V
This contains the PVD and also contains the positions of the data files.

User data or audio is written in the program area which can contain up to 99 tracks. CD-ROM
tracks are always placed before audio tracks when both are present on a mixed mode CD.

There is always a lead-out at the end of a CD which prevents the read head from reading past
track.

6HFWRU�DGGUHVVHV�RQ�D�&'��PP�VV�II�

Sector positions on a CD are expressed as absolute or relative time in minutes, seconds and
(a frame is the same as a sector) in the format mm:ss:ff (also written as MSF). They can also
expressed as a sector number.

$EVROXWH�WLPH

This is the position of a sector relative to the absolute time at the beginning of the CD
disadvantage of using this system is that if you edit a track or file at the beginning of 
CD so that it becomes longer or shorter, the absolute times for each subsequent sec
data will change and must be recalculated.

5HODWLYH�WLPH
��
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This is the position of a sector relative to some other point on the CD such as the beg
of a track, file or extent (an extent is a specified number of sequential blocks on the 
It is more convenient to use relative time because if changes are made in track one 
example, only the addresses of sectors in track one are affected, the start times of a
subsequent tracks will change but the relative times within each track remain the sa

6HFWRU�QXPEHU

Often only the sector number is given in a seek or read command or to express the 
address of a file on a CD. For this purpose sectors are counted from the first sector 
first track which is sector zero. Each sector increments by one up to n depending on
much data the CD holds.
��
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Tracks on a CD can be considered similar to the tracks you see on an LP vinyl record, and in 
an audio music CD, each song is written on a separate track in just the same way.

A catalogue or reference CD-ROM which contains lots of data files, such as a CD-ROM font lib
will probably just have a single track where all the files are recorded. A typical game or educa
CD-ROM, containing data and audio, may have a single Mode 1 track containing the data foll
by several audio tracks.

There are three types of track in which data can be written on a CD. The type of tracks you u
depends on the type of data you are recording.

127(�127(� *'�:RUNVKRS�GRHV�QRW�VXSSRUW�0RGH���

The definitions given here are brief. See also Reference documents.

0RGH��

This is a standard Yellow Book CD-ROM track where the sectors have three layers of error 
correction which makes this type of track robust and suitable for computer data.

0RGH��

This is a Yellow Book CD-ROM/XA track where the sectors have additional subheader informa
which makes them suitable for interleaving real-time audio and compressed audio/video files

There are two types of Mode 2 track, Form 1 and Form 2, which have different amounts of er
correction built in depending on how robust the system needs to be. For example, a Mode 2 
carrying computer data will need to be Mode 2, Form 1 because of the extra EDC layer, whe
compressed audio and video can be carried on a Mode 2, Form 2 track because it is a more 
data type.
��
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This is standard Red Book audio track which can contain up to 74 minutes of digital hi-fi aud
��
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When you drag and drop files into an empty project window the relative paths to the files are c
into the project, not the absolute paths.

For example, if all your project files are in a directory called “PROJECT” on the development
computer, all the files will appear in root on the CD when they have been copied. The “PROJ
part of the path is not copied because it is the same for all the files.

Any sub-directories of “PROJECT” will appear in root on the CD.
��
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,62�����DQG�LWV�H[WHQVLRQV

There are various file naming systems for directories and files which form the content of a C
These systems are based on ISO9660 Level 1 which is the basic standard for CD-ROM inform
exchange as defined by ISO9660.

ISO9660 Level 1 is very versatile in that it works on all operating systems, but is very restricti
terms of the characters that you can use to name your files and directories.

As CD-ROM production has evolved, extensions have been added to ISO9660 to incorporate 
of new file naming systems (such as Windows® 95 long file names) so that a CD can use file 
which are compatible with the operating system on the target computer. This makes CDs mo
friendly.

However, as a CD-ROM developer you must make sure that all your potential customers can
the file naming system you use. For example, if you use Windows 95 long file names on you
you must be sure that all your customers are running Windows 95 on their computers.

11227(�7(� &XUUHQWO\�*'�:RUNVKRS�VXSSRUWV�,62�����/HYHO���DQG�/HYHO���LQWHUFKDQJH�

$XGLR

Select this if you want to create an audio only CD. There are no restrictions placed o
length or format of file names.

,62�����/HYHO��

This file naming system uses only d-type characters in 8.3 format.

,62�����/HYHO��

This file naming system uses only d-type characters.

Up to 30 characters for file names. When a file name has no extension, the file name
end with a Period “.”.

Up to 31 characters for directory names.
��
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Used for Unicode character sets and Windows 95 filenames up to 64 characters. No
implemented in this release of GD Workshop.

5RFN�5LGJH

Used in UNIX systems. Not implemented in this release of GD Workshop.

+)6

Used in hybrid and Macintosh discs. Not implemented in this release of GD Worksho
��
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If you add files to a CD which do not comply with the file system you specified, GD Workshop
automatically fixes the file names to make them comply.

GD Workshop tries to make a meaningful name by substituting illegal characters and using nu
when duplicate names occur.

For example, if you try to add three files with Windows 95 long filenames to a CD which has 
ISO9660 Level 1 specified as its file naming system, the file names would be fixed as shown 

File Name a.txt becomes FILENA_1.TXT

File Name b.txt FILENA_2.TXT

File Name c.txt FILENA_3.TXT

and

Directory a becomes DIRECT_0

Directory b DIRECT_1

Directory c DIRECT_2

11227(�7(� 7KH�IL[HG�ILOH�QDPH�LV�VKRZQ�LQ�WKH�SURMHFW�WUHH�DQG�WKH�IL[HG�DQG�RULJLQDO�ILOH�QDPHV�DUH�

VKRZQ�RQ�WKH�)LOH�1DPH�WDE�ZKHQ�\RX�VHOHFW�WKH�ILOH�LQ�WKH�WUHH�

3HUPLWWHG�,62������FKDUDFWHUV

,62������G�W\SH�FKDUDFWHUV

Uppercase letters A to Z, numbers 0 to 9 and the underscore symbol “_”.

,62������D�W\SH�FKDUDFWHUV

Uppercase letters A to Z, numbers 0 to 9 and symbols (space) _ * ? ! ; % & - = > < ‘ “ ( )
��
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)LOHV�JHQHUDWHG�E\�*'�:RUNVKRS

When you click Close Door to emulate the “virtual” CD you have created, GD Workshop gene
the following files:

�+&'

This is used by the GD-M when emulating the project and contains the table of conte
(TOC) and run time information such as the begin and end time (sector number on the
of each file.

�9'6

This is part of the ISO9660 specification and is used by the operating system of the t
computer (for example Windows 95). It contains the PVD and also contains informat
about each file and its position on the CD.

�6)$�DQG��6),

These files are created if your CD contains lots of small files and you have instructed
Workshop to use small file archives. See also How and when to use small file archive

The files listed above can only be seen if you access the emulation drive. They are created fo
emulation when you click Close Door. The size of the files depends on the complexity of the 
project but can be several megabytes for a complex CD.
��
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+RZ�DQG�ZKHQ�WR�XVH�VPDOO�ILOH�DUFKLYHV��6)$V�

If your CD project contains small files less than 32K (the cluster size of the emulation hard d
emulation or writing can be compromised at high speeds. GD Workshop solves this problem
combining small files into larger files called SFAs. Using SFAs improves the data retrieval rate
the GD-M during emulation.

To use SFAs:

1) Select Workshop on the Configuration menu.

2) Select Create Small File Archives on the Workshop Settings dialog box.

When GD Workshop prepares to emulate, it looks at the files in the project and where there a
or more contiguous files which are smaller than 32K each, they are combined into an SFA. Fo
SFA created, an index of its contents is also created (SFI). These files reside on the GD-M’s
emulation drive and should not be edited directly.
��
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This chapter describes each field on the tab controls and what information can be entered to e
properties of files and tracks on the CD.

It has the following sections:

• Using the tab controls

• Disc

• Primary Volume Descriptor (PVD)

• Boot

• Track

• Digital Audio

• Directory

• File Name

• File Source

• Hard Errors
���
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The tab controls let you edit various properties of your CD project. When you click on a bran
the project tree, the relevant tab appears and you can edit its properties.

The Apply, Cancel and Help buttons that appear at the bottom of each tab window are also av
on the Tabs toolbar shown here.

This toolbar is docked at the top of the screen when you first start GD Workshop, but you wil
it useful to have it floating above the tabs when making edits so that you do not have to scroll
bottom of the tab window each time you want to apply or cancel a change.

To get detailed help about what the options on a particular tab mean click Help at the bottom
tab window or on the Tabs toolbar.

'DWH�DQG�WLPH

• Dates are given as day, month, year in the format DD/MM/YYYY.

• Times are given as hours, minutes, seconds, milliseconds and GMT offset in the fo
hh:mm:ss:ll:gmto.
GMT offset is the difference between local time and Greenwich Meantime in 15 min
units. For example, Japan which is 9 hours ahead of GMT has an offset of 36 (9x4)
not necessary to enter the date and time in full, if you just enter the date, the time w
ignored and this will have no impact on the emulation or recording process.
��
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This tab defines the outer most level of the CD you are creating.

'LVF�1DPH

8.3 ISO 9660 d-type characters

Enter a title for the CD.

&DWDORJXH�1XPEHU

Numerical up to 13 digits

Enter a catalogue number for the CD. This is required by a publisher if you intend to pu
the CD. For a Sega GD-ROM, the catalogue number must be obtained from Sega

6\VWHP�$UHD�)LOH

ISO 9660 d-type characters

Enter the name and the path of the System Area File which contains the territory iden
for a GD-ROM.
��
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This tab defines the header information which goes in the PVD. This is information about the
such as the creator, creation date and copyright. See also GD-ROM layout and sector addre

The PVD information is broken down into the following categories:

• Volume Information
• Copyrights
• Miscellaneous
• File Name Information

9ROXPH�,QIRUPDWLRQ

,GHQWLILHU

Up to 32 d-type characters

Enter a name for the CD. This is usually the title of the GD-ROM.

6HW�,GHQWLILHU

Up to 128 d-type characters

Enter the overall name of the volume to appear on each CD if it is part of a multiple C
set. If there is only one CD in the set, the Identifier and Set Identifier are the same.

For example, a three CD volume set could have the Set Identifier 
ENGLISH_DICTIONARY”, and the CDs in the set could have Identifiers “A_J”, “K_S
and “T_Z”.

&UHDWLRQ�'DWH

DD/MM/YYYY hh:mm:ss

The default is the date and time when you started the project. To change this, enter 
different date and time.

0RGLILFDWLRQ�'DWH
��
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The default is the date and time when you last modified the project. To change this, e
different date and time.

([SLUDWLRQ�'DWH

DD/MM/YYYY hh:mm:ss

If the CD contains data that may become obsolete in the future, you can set an expir
date after which the data will no longer be accessible. The default is the creation date
9 years.

(IIHFWLYH�'DWH

DD/MM/YYYY hh:mm:ss

If you do not want the data on the CD to be accessed before a certain date you can 
effective date here. The default is the creation date.

&RS\ULJKWV

3XEOLVKHU

Up to 128 a-type characters

Enter the name of the publisher or organisation who owns the copyright of the CD.

'DWD�3UHSDUHU

Up to 128 a-type characters

Enter the name of the data preparer. This can be the name of an individual or an 
organisation.

$SSOLFDWLRQ

Up to 128 a-type characters

Enter the name of the application that can use the data on the CD.
��
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6\VWHP�,'

text string

This defines the system that the CD is intended to be played on, for example, IBM™P
Macintosh™.

/RJLFDO�%ORFN�6L]H

This is the logical block byte length for the data on the CD. This is set to 2048 which i
same as a sector length.

)LOH�1DPH�,QIRUPDWLRQ

&RS\ULJKW

8.3 d-type characters

Enter the name of the file that contains the copyright message.

$EVWUDFW

8.3 d-type characters

Enter the name of the file that contains the abstract information such as a text descr
of the CD.

%LEOLRJUDSKLF

8.3 d-type characters

Enter the name of the file that contains the bibliography for the CD.

$SSOLFDWLRQ�8VH

The information required in this field is not defined. It is available for future additions
the ISO9660 specification.
��
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127(�127(� 7KLV�IHDWXUH�LV�QRW�DYDLODEOH�IRU�*'�520�

To make a bootable CD, you need a bit-for-bit image of the boot record which will boot the ta
system. This can be an image of a boot floppy (1.2, 1.44 or 2.88 MB), a hard drive or any raw
code. You can place more than one boot image on a bootable CD and when the CD is read b
Torito compatible CD drive a menu is displayed so the user can choose which image to boot

%RRW�(QWU\

Up to 32 d-type characters

Enter a text string to identify the boot record you are adding, such as the name of the s
or the creator of the CD. Then click on the Add button to activate the Boot tab.

)LOH�1DPH

D-type characters

Browse for the file which contains the boot image you are adding to the CD. 

3ODWIRUP

Select the type of platform the boot image in intended for.

,PDJH�FRQWDLQV�$7$3,�6&6,�GULYHUV

Select the type of drivers included in the boot image.

/RDG�6HJPHQW

Hexadecimal

Enter the load segment where the system will load the boot image. If this value is zer
system will use the standard load segment of 7C0.

/RDG�5%$
��
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This is the relative address of the start sector where the boot image is written on the
calculated by Mirage Workshop. For example the RBA of 15H means that the boot im
starts at sector 21 (decimal) on the CD.

Repeat the above entries for each additional boot image required.
��
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This tab shows the position of the track selected in the tree.

127(�127(� 7KH�SRVLWLRQ�RI�D�WUDFN�FDQQRW�EH�FKDQJHG��EXW�\RX�FDQ�PRYH�WKH�FRQWHQWV�RI�D�WUDFN�WR�D�

QHZ�WUDFN�DQG�WKHQ�GHOHWH�WKH�RULJLQDO�WUDFN��6HH�DOVR�&RS\LQJ�DQG�PRYLQJ�ILOHV�

3UH�JDS

Numerical

A pre-gap assists transition of the read head between tracks of different types. Enter
number of empty blocks (user data that is all zeros) to be added as a pre-gap at the be
of a data track. One block lasts for one seventy-fifth of a second and a pre-gap should
least 150 blocks or two seconds.

A pre-gap is required:

• on the first data track after an audio track

• between data tracks of different types.

A pre-gap is not required between data tracks of the same type or before the first tra
the CD.

3RVW�JDS

Numerical

A post-gap assists transition of the read head between tracks of different types. Ente
number of empty blocks (user data that is all zeros) to be added as a post-gap at the
a data track. One block lasts for one seventy-fifth of a second and a post-gap should
least 150 blocks or two seconds.

A post-gap is only required:

• on the last data track before the lead out at the end of CD

• on a data track followed by an audio track on a mixed mode CD.
��
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'LJLWDO�$XGLR

This tab lets you specify certain attributes which apply to digital audio tracks (CD-DA).

3DXVH

Numerical

Enter the number of empty blocks to be paused (audio silence) at the beginning of a C
track. This assists transition of the read head between CD-DA tracks. One block las
one seventy-fifth of a second and a typical audio pause is 150 blocks or two second

3UH�HPSKDVLV

This specifies whether the source file for the audio track was recorded with pre-emp
applied.

����&KDQQHOV

This specifies the number of channels for the audio track. This can be two or four fo
CD-DA audio track and defaults to two.

&RS\�3URWHFW

This tells GD Workshop to record the audio track with a copy protect mechanism swit
on. When it is checked digital copying is not permitted.

7UDFN�1XPEHU

This shows the position of the audio track selected in the tree and allows you to chan
track order.

To change the position of an audio track:

1) Select the track you want to move in the tree.

2) On the Digital Audio tab, click the up or down arrow next to the track num
until the track is in the required position. The other tracks on the CD are
re-arranged automatically.

3) Click Apply.
��
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This tells GD Workshop that the audio track is a padding track. See also Adding a 
track.Adding a track
��
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This tab lets you set various properties which apply to the selected directory.

'LUHFWRU\�1DPH

This is the path to the directory on the CD in which ISO 9660 files are recorded. Usu
this will just be “\” if the files are placed directly onto the CD.

See also Relative paths.Relative paths>refer

+LGGHQ�5HFRUG�'LUHFWRU\

Check these if you want the directory to be a hidden or record directory.

0LQLPXP�/HQJWK

This specifies the minimum number of bytes that the directory record occupies regar
of its actual size. If the directory record is smaller than this number, it is zero filled to
specified size.

This allows room for additions to the directory record without affecting its overall size

5HFRUGLQJ�'DWH

DD/MM/YYYY hh:mm:ss

This defaults to the creation date and time unless you enter a different date and time
��
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This tab lets you edit various attributes which apply to the selected file in the tree.

)LOH�1DPH

This is the name given to the file by GD Workshop when it is added to the tree. This 
be different from the name of the source file if it has been fixed to comply with the file
naming system specified for the CD. See also File naming conventions and restrictio

(UURUV

This is a shortcut to the Hard Errors tab. See also Hard Errors.

'LUHFWRU\

This is the directory on the CD in which the selected file is recorded.

Click More for a short-cut to the directory tab. See also Directory.

)LOH�6RXUFH

This is the directory and file name of the file source on the emulation drive which the G
reads when emulating the CD.

Click More for a short-cut to the file source tab. See also File Source.

+LGGHQ�5HFRUG�)LOH

Check these if you want the file to be a hidden or record file.

0LQLPXP�/HQJWK

This specifies the minimum number of bytes for the area of the file regardless of the a
size of the file. If the file is smaller than this number, it is zero filled to the specified si

This allows room for additions to the file without affecting its overall size.

5HFRUGLQJ�'DWH
��
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DD/MM/YYYY hh:mm:ss

This defaults to the creation date of the CD unless you enter a different date and tim

%HJLQ�7LPH�6

mm:ss:ff

This option lets you set the start position of the file relative to the start position of the
session.

If you do not specify the begin time, the files are recorded on the CD consecutively i
next available sector.

(QG�7LPH�6

mm:ss:ff

This option lets you set the end position of the file relative to the start position of the
session. The start position of the file is calculated so that the file ends at the specifie
position.

If you do not specify the end time, the files are recorded on the CD consecutively in 
next available sector.

)LOH�6L]H

This is the size of the selected file read from the emulation drive. This information is
provided to give you an indication of the final size of the CD as you add files to it. It a
provides a useful way to check that files have copied correctly, by comparing the file
given here with the file size on the development computer.

9HUVLRQ

Numerical 1 to 32767

This is the version number of the file and defaults to 1 if nothing is entered in this fie

6WDUW�6HFWRU�(QG�6HFWRU
��
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These show the start and end position of the selected file, which is given as the sect
number relative to the beginning of the session. For this purpose the first sector on th
in which user data is recorded is sector zero (0).

6\VWHP�([HFXWH�DQG�6\VWHP�5HDG�$WWULEXWHV

These options are for use in Unix™ systems where user access to files is defined by
categories Owner, Group or World. If your project is being written for Unix systems, e
file on the CD can be marked with one of these categories.
��
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)LOH�6RXUFH

This tab lets you add and delete source data from the selected file in the project tree.

An ISO 9660 file on a CD can be made up of more than one file source. This can be useful, 
example, to record a set of image files which are combined to make up an animated graphic u
common file name.

If the ISO 9660 file is made up of multiple file sources, all the file sources which make the ISO
file are listed in the drop down box.

)LOH�6RXUFH

MS-DOS path and filename

This is the path and file name of the file source on the emulation drive.

During CD emulation this file is read by the GD-M and must be located on the emula
drive. The emulation will fail if this field does not contain the full path and file name, 
including the drive letter.

$GG�'HOHWH

To add a file source to this list click Add and browse for the file you want to add. To de
a file click Delete.
��
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This tab lets you add errors into a file to test how robust your data is. See also Emulating erro
CD.

)LOHQDPH

This is the selected file in the tree to which you can add errors.

6WDUW�(QG�6HFWRU

These are the start and end sectors of the selected file.

)URP�7R

Specify the range of bad sectors which you want to add to the file.

$GG�'HOHWH�5HPRYH�$OO

Use these buttons to add and delete the errors in the file.
��
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This glossary includes terms which you might come across in your day-to-day work with 
GD Workshop and CDs.

$�7LPH�$EVROXWH�7LPH

The time elapsed since the start of the CD measured from the beginning of Track 1.

$FFHVV�7LPH

The time taken by the laser to move to a particular place on the CD. Maximum access 
time is the time taken to move from the start of the CD to the end and begin to retrieve 
data. Average access time is the average time taken to move from one position on the CD 
to another.

$16,

A set of standards defined by the American National Standards Institute.

$63,��$GYDQFHG�6&6,�3URJUDPPHU
V�,QWHUIDFH�

A set of routines and data structures which allow programs to be SCSI host adapter inde-
pendent.

%XLOGLQJ�$Q�,PDJH

The process of taking the data files which make up the CD (executables, graphics, audio 
and video) and creating a single continuous CD image which is used with some CD-Writ-
ing software to write a CD-R. The Mirage does not need a CD image to emulate or write a 
CD, the image is created in real-time.

%XUQ

The process of recording a CD-R in a CD Writer. So called because a laser is used to 
'burn' lands and pits onto the CD. Also known as CD Writing.
��



&DFKH

A portion of RAM set aside as a temporary store for frequently accessed data such as 
directory information.

&DGG\
A carrier used with some CD-ROM drives to hold the CD. CD-ROM drives which do not 
use caddies are known as “caddyless”.

&$9��&RQVWDQW�$QJXODU�9HORFLW\�

A CD drive that spins at a constant speed so that data retrieval at the outside of the CD is 
faster than at the inside.

&'�'$��&RPSDFW�'LVF�'LJLWDO�$XGLR�

The standard for audio CDs. Developed by Sony and Philips and launched in 1982. 
Defined in a document known as the Red Book. Also known as CD-Audio. Reads digital 
sound samples off the CD at 44.1Khz per second. Audio CDs are capable of storing up to 
75 minutes of sound (at single-speed), although only 60 minutes is commonly quoted as 
the maximum capacity.

&'�,��&RPSDFW�'LVF�,QWHUDFWLYH�

A format standard for interactive multimedia applications developed by Philips. Defined in 
a document known as the Green Book.

&'�:ULWHU

The name given to CD devices which can write as well as read CDs. The special writeable 
CDs are called CD-Rs. The standard for CD-R is defined in the document known as the 
Orange Book.
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&'�:ULWLQJ�6RIWZDUH��&'�:ULWHU�6RIWZDUH�

The software which controls a CD Writer and transfers data from the source (usually a 
computer's HD) onto a CD-R adding error correction codes (ECC) and error detection 
codes (EDC).

&'�5��&RPSDFW�'LVF�5HFRUGDEOH�

A writeable CD-ROM used by a CD Writer to store data. Conforms to the CD-ROM WO 
standard. Also known as gold discs.

&'�520��&RPSDFW�'LVF�5HDG�2QO\�0HPRU\�

The standard for CDs which can hold computer data. Defined in a document known as the 
Yellow Book.

&'�520�'ULYH��&RPSDFW�'LVF�'ULYH�

A computer peripheral which can read CD-ROM. CD-ROM drives can usually also play 
audio (Red Book) CDs. CD-ROM drives are rated as single-speed, double-speed, 
quad-speed or six-speed depending on their data access rate.

&'�520�:2��&RPSDFW�'LVF�:ULWH�2QFH�

A recordable CD. Another name for CD-R or gold discs. The CD-ROM WO standard is 
defined in a document called the Orange Book.

&'�520�;$��&RPSDFW�'LVF�([WHQGHG�$UFKLWHFWXUH�

An extension of the Yellow Book (CD-ROM) standard. Consistent with the ISO 9660 for-
mat standard, but with some video and audio capabilities taken from the CD-I standard. 
CD-ROM XA is also the standard format for Photo-CDs.

&,5&��&URVV�,QWHUOHDYH�5HHG�6RORPRQ�&RUUHFWLRQ�

The data correction algorithm used to correct large runs of unreadable data due to laser 
error, damage or scratches on CDs. CIRC interleaves the frames of data and the error 
checking is performed on the sum of this data. Error bursts of up to 450 data bytes can be 
corrected using CIRC. The CIRC method results in an error rate of less than one unrecov-
erable error in 2,000 CDs.

&ORVHG�'LVF
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A multi-session CD-R (recordable CD) is closed so that no further data can be written to it. 
This is done by not recording the next writeable sector in the lead-in of the current session, 
see Lead-in. The CD writing software has no way of knowing where to write new data and 
therefore the CD cannot be written to again.

&ORVH�6HVVLRQ

To close a session, the CD's table of contents is updated and a lead-in (the next writeable 
sector) is written to the CD to allow the CD writing software to write further sessions to the 
CD.

&/9��&RQVWDQW�/LQHDU�9HORFLW\�

A CD drive that uses varying rotation speeds to maintain the speed at which data passes 
under the read head as it moves across the CD.

&XH�6KHHW

A list of tracks to be written to a CD in a particular session.

'DWD�$UHD

Part of the ISO 9660 standard. The area of the CD where data can be written. Begins at 
absolute time 00:02:16 (the first available space after the Table Of Contents).

'HYHORSPHQW�+RVW

The generic name for a development computer. Examples include: PC and Macintosh.

'LUHFWRU\

A library of pointers stored in a specific area of the CD which shows the location of all of 
the files on the CD.

'LVF�,PDJH

A single file containing an image of a CD. Includes all data files (executables, graphics, 
audio and video) along with ECC and EDC codes.

'RXEOH�6SHHG

A CD-ROM drive which can read CDs at twice the speed of a single-speed drive giving a 
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data rate of 150 sectors per second.

(&&��(UURU�&RUUHFWLRQ�&RGH�

A code which is added to the data being written onto a CD by CD Writing software. Allows 
the detection and correction of read errors.

('&��(UURU�'HWHFWLRQ�&RGH�

A 32 bit code which is used as a checksum to detect data errors.

(UURU�5DWH

The rate that errors occur when data is read from the CD.

)LUPZDUH

Programs stored in Read Only Memory (ROM) chips.

)ODVK

A special type of Erasable Programmable Read Only Memory (EPROM) which can be 
re-written by a computer, such as the Mirage's controller board and upgraded.

)RFXV�7LPH

The time taken for the read head to focus on the track when it arrives at a specified sector 
on the CD, before it can begin to read data.

)UDPH

Also known as a sector. 2352 bytes of data. 75 frames per second is known as sin-
gle-speed.

*'�520

The name given to a Sega game CD for the Katana. It always contains two sessions. 

*ODVV�0DVWHU

The glass image of the CD produced from the CD-R by a duplication house. Used as the 
master in the duplication of the final production CDs.
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*UHHQ�%RRN

The document which defines the standard for Compact Disc Interactive (CD-I).

+HDGHU�)LHOG

Four bytes recorded at the beginning of every sector which contain the sector's address 
and the mode in which the sector is recorded.

+)6��+LHUDUFKLFDO�)LOLQJ�6\VWHP�

The disk filing system used on the Apple Macintosh.

+LJK�6LHUUD�)RUPDW

The standard for logical CD format. Originally proposed by the High Sierra Group and 
essentially identical to the ISO 9660 standard.

+\EULG

A CD which is a combination of ISO 9660 and Macintosh HFS. Used by CD-ROM develop-
ers to deliver data to users of both formats, but on one CD (for example magazine cover 
CDs).

,62�����

The standard for information exchange on CDs upon which most other formats are based.

,62������,PDJH

Another name for Virtual Image.

/DQG

Flat area on the surface of a CD which reflects laser light back to the sensor on the read 
head. Represents a value of '1'.

/DVHU

The read-head in a CD mechanism. Reads lands and pits on the CD's surface.

/HDG�,Q

A 4,500 sector (about 9 MB) area of a CD-R which is written at the beginning of each ses-
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sion. Gives details of the contents of the session and contains the next writeable address 
on a CD if the CD is multi-session and not closed.

/HDG�2XW

An area of a CD-R which indicates the end of a particular session.

/RJLFDO�%ORFN

The smallest addressable section on a CD. In the ISO9660 standard each logical block is 
given a Logical Block Number (LBN) starting at zero at the beginning of the CD.

0DVWHU

The glass image of the CD produced from the CD-R by a duplication house. Used as the 
master in the duplication of the final production CDs.

0DVWHULQJ

The process whereby a master is produced.

0L[HG�0RGH�&'

A CD which contains both computer and audio (CD-DA) tracks. The computer data is all 
contained in track 1 and the remainder of the CD can be used for the audio tracks.

0RGH��

A track format containing all zeros.

0RGH��

A track format specified in the Yellow Book. 2,048 bytes of data followed by 288 bytes of 
EDC and ECC information.

0RGH��

A track format specified in the Yellow Book. 2,048 bytes of data followed by another 288 
bytes of data with no error correction.

0RXQW

The process of inserting a CD into a computer's CD-ROM drive so that the computer can 
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read data from it. Also used to describe the process of informing the computer that a CD 
has been inserted.

0XOWL�6HVVLRQ

Indicating a CD-ROM which contains data written in more than one session. Also used to 
denote a CD-ROM drive which can read multi-session CDs.

2Q�7KH�)O\�&'�:ULWLQJ

The process of writing a CD-R directly from the source data without having to first build a 
complete CD image. Also used to describe emulation of a CD without having to build a 
complete CD image.

2UDQJH�%RRN

The document which defines the standard for writeable CDs including CD-R, mag-
neto-optical cartridge systems and single-session and multi-session CDs.

3&$��3RZHU�&DOLEUDWLRQ�$UHD�

A reserved area at the beginning of a CD used by a CD-Writer to calibrate the laser prior to 
recording on the CD.

3KRWR�&'

A format, defined by Kodak, based on the CD-ROM XA and Orange Book definitions 
which is used to store photographs in five resolutions (standard CD) or six resolutions (pro 
CD) which range from display to full colour magazine standard.

3LW

Area on the playing surface of a CD which scatters the laser's light. Represents a value of 
'0' (zero).

3/$<72&

A command issued by the target to the CD mechanism. It requests that the mechanism 
reads data from the CD's table of contents at single speed.

30$��3URJUDP�0HPRU\�$UHD�
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An area of a CD-R which contains the session contents information while the tracks are 
written to the CD. This information is then written to the session's lead-in.

3RVW�*DS

A gap written after a track.

3UH�*DS

A gap written before the start of a track.

3UH�0DVWHULQJ

The process of dividing data into sectors and tracks and adding the appropriate header 
and error correction information prior to writing the CD.

PVD (Primary Volume Descriptor)

Part of the VDS. The PVD contains information about the CD, its creator and copyrights.

4XDG�6SHHG

A data rate of 300 sectors per second. Written as 4X.

5HDG�+HDG

The laser in a CD-ROM drive which reads the data contained in the pits and lands on a 
CD.

5HG�%RRN

The document, developed jointly by Sony and Philips, which defines the standard for 
CD-Audio including CD format, hardware, form factors and media specifications. Also 
forms the basis for the Yellow Book and High Sierra standards. The Red Book defines the 
way that bit patterns are written to the CD, provides for synchronisation bytes and sup-
ports one layer of CIRC error correction within each frame or packet of data.

5HODWLYH�7LPH

The time elapsed since the start of a particular track.

6&6,��6PDOO�&RPSXWHU�6\VWHPV�,QWHUIDFH�
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A standard interface which allows the connection of up to eight devices to a single control-
ler. Pronounced “scuzzy”.

6&6,�%XV�6&6,�&KDLQ

The name given to the data bus which connects devices via the SCSI standard. Each end 
of a SCSI chain must be terminated.

6&6,�7HUPLQDWLRQ

The process of placing a small resistance at each end of a SCSI chain. This resistance 
stops signal reflection and thereby errors. Only the ends of the SCSI chain should be ter-
minated.

6HFWRU

Also known as a frame, 2352 bytes of data. 75 sectors per second is known as sin-
gle-speed.

6HHN�7LPH

The time taken for the read head to move from one track on a CD to another.

6HVVLRQ

A single recording session on a multi-session CD-R. Each session starts with a lead-in and 
finishes with a lead-out. Part of the Orange Book definition for writeable CDs.

6HWWOLQJ

The time taken for the laser to focus once it has reached the requested position on the CD.

6LQJOH�6HVVLRQ

A CD-ROM player which can only read CDs which have been written in one complete ses-
sion or can only read the first session on a CD.

6LQJOH�6SHHG

A data rate of 75 sectors per second.

6L[�6SHHG
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A data rate of 450 sectors per second.

6SLQ�XS�7LPH

The time taken in milliseconds to start the CD spinning and accelerate up to operating 
speed.

6723

A command issued by the target to the CD mechanism. It requests that the mechanism 
stops sending data and stops spinning the CD.

7DUJHW

The generic name for a target computer. Examples include: PC and Macintosh.

7HUPLQDWLRQ

See SCSI Termination.

72&��7DEOH�2I�&RQWHQWV�

Written into the lead in area of a CD and containing information about the number of 
tracks, their starting locations on the CD and the total length of the data area on the CD.

7UDFN

An area on a CD where data or audio is recorded. There are four type of track Mode0, 
Mode1, Mode 2 and CD-DA.

9LUWXDO�,PDJH

A table of pointers to the files to be written on a CD. Used to write CDs on-the-fly or to 
build a CD image prior to the CD being written.

9ROXPH

A single CD-ROM. Part of the ISO 9660 definition.

9'6��9ROXPH�'HVFULSWRU�6HW�

The area of the CD starting at sector 00:02:16 which contains the PVD and information 
about the directory structure and start sectors for the files on the CD. Part of the ISO 9660 
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*'�:RUNKRS�8VHU�*XLGH
definition.

:KLWH�%RRN

The document which defines the standard for Video CD format CDs.

:250��:ULWH�2QFH�5HDG�0DQ\�

Removable optical media which can only be written to once, but can be read many times. 
Not compatible with CDs.

:ULWHDEOH�6HFWRU

The address of the next sector where data can be written on a multi-session CD-R, written 
in the lead-out information from the previous session.

<HOORZ�%RRN

The document which defines the standard for data on CD-ROM. Originally devised by 
Philips and Sony. Based on the Red Book audio standard, but with better error correction.
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.H\ERDUG�VKRUWFXWV
.H\ERDUG�VKRUWFXWV
The keys listed below have been assigned to speed up frequently used commands:

&RPPDQG )XQFWLRQ�NH\V

2SHQ�KHOS )�

(GLW�VHOHFWHG�LWHP�LQ�WUHH )�

&DQFHO�)� (6&

'RRU�2SHQ�&ORVH )�

(PXODWRU�&'�520�VZLWFK )�

1XGJH )�

(QDEOH�HUURUV &RQWURO�)�

&ROODSVH )�

&ROODSVH�$OO 6KLIW�)�

([SDQG )�

([SDQG�$OO 6KLIW�)�

6ZLWFK�WUHH�OLVW�YLHZ )�

&RPPDQG 6KRUWFXW�NH\V

2SHQ &RQWURO�2

1HZ &RQWURO�1

6DYH &RQWURO�6

&RS\ &RQWURO�&

&XW &RQWURO�;
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3DVWH &RQWURO�9

8QGR &RQWURO�=

&RPPDQG 6KRUWFXW�NH\V
s 
7DVN�EDU�FRQWUROV

The following emulator controls are available from the right-click menu when GD Workshop i
minimised on the task bar.

• Open/Close Door.
• Switch between GD-ROM drive and GD emulator.
• Select the CD you want to emulate.

$GG�&' &RQWURO�6KLIW�&

$GG�VHVVLRQ &RQWURO�6KLIW�6

$GG�OHYHO��ILOH�QDPLQJ�V\VWHP &RQWURO�6KLIW��

$GG�OHYHO��ILOH�QDPLQJ�V\VWHP &RQWURO�6KLIW��

$GG�GDWD�WUDFN &RQWURO�6KLIW�'

$GG�DXGLR�WUDFN &RQWURO�6KLIW�$

$GG�GLUHFWRU\ &RQWURO�'

$GG�ILOH &RQWURO�6KLIW�)

&RPPDQG 6KRUWFXW�NH\V
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vant to 
re are 
5HIHUHQFH�GRFXPHQWV
This list includes several sources of reference document, not all these documents will be rele
your CD project depending on the type of CD you are creating. The list is not exhaustive, the
many other publications available from other companies and organisations which are worth 
searching for.

$YDLODEOH�IURP�6HJD�'76

GD Workshop Manual

Katana development box Installation Manual

,62�6SHFLILFDWLRQV

ISO 9660 Volume and file structure for CD-ROM for information exchange

$YDLODEOH�IURP�3KLOLSV�6RQ\

Red book Compact Disc Digital Audio Standard Specification

$YDLODEOH�IURP�0LFURVRIW

Joliet CD-ROM Recording Specification ISO 9660 Extensions for Unicode

$YDLODEOH�IURP�5RFN�5LGJH�7HFKQLFDO�:RUNLQJ�*URXS

Rock Ridge Interchange Protocol Version 1

$YDLODEOH�IURP�3KRHQL[�7HFKQRORJLHV�,%0

El Torrito Bootable CD-ROM format specification.

$YDLODEOH�IURP�'LVF�0DQXIDFWXULQJ�,QF�

Introduction to ISO 9660

Compact Disc Terminology

A Glossary of CD and CD-ROM Terms
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